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Abbrevations

AC Heart rate acceleration capacity (AC) index
ACQ AcqKnowledge data file format (Biopac Inc.)
ANS Autonomic nervous system
ApEn Approximate Entropy
AR Autoregressive (model or process)
ASCII Text file using the ASCII character set, which is the most common format for English-

language text files
CSV Comma separated value (file format)
DC Heart rate deceleration capacity (DC) index
DFA Detrended fluctuation analysis
ECG Electrocardiogram
EDF European data format (file format)
EE Energy expenditure
FFT Fast Fourier transform
GDF General data format (file format)
GUI Graphical user interface
HF High frequency (refers to HRV frequency band, by default 0.15-0.4 Hz)
HR Heart rate
HRV Heart rate variability
IBI Inter-beat-interval (same as RR interval)
LF Low frequency (refers to HRV frequency band, by default 0.04-0.15 Hz)
MAT MATLAB data file format (Mathworks Inc.)
MSE Multiscale entropy
NNxx Number of successive RR interval pairs that differ more than xx msec
PDF Portable document format (file format)
pNNxx Relative number of successive RR interval pairs that differ more than xx msec
PNS Parasympathetic nervous system
PPG Photoplethysmogram (measurement of blood volume changes)
QRS QRS complex of electrocardiogram
RESP Respiration rate
RMSSD Root mean square of successive RR interval differences
RPA Recurrence plot analysis
RR Time interval between successive ECG R-waves (RR interval, same as IBI)
SampEn Sample entropy
ShanEn Shannon entropy
SDANN Standard deviation of the averages of RR intervals in 5-min segments
SDNN Standard deviation of normal-to-normal RR intervals
SDNNI Mean of the standard deviations of RR intervals in 5-min segments
SI Stress index
SNS Sympathetic nervous system
SPSS Statistical analysis software package(IBM Corp.)
TINN Triangular interpolation of normal-to-normal intervals
TRIMP Training impulse
VLF Very low frequency (refers to HRV frequency band, by default 0-0.04 Hz)
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1 Overview

1.1 About Kubios HRV

KubiosHRV is a gold-standard heart rate variability (HRV) analysis software designed for research and professional
use. Kubios HRV software is used at roughly 1200 universities in 128 countries. With Kubios HRV, you can turn
your ECG or HR monitor into a powerful tool to probe the cardiovascular system or to evaluate the effect of stress
and recovery on heart health. The software is suitable for clinical and public health researchers, professionals
working on human well-being, or sports enthusiasts; for anybody who want to perform detailed analyses on heart
rate variability, e.g. to examine autonomic nervous system function.

The first versions of the Kubios HRV were developed as part of academic research work carried out at the Depart-
ment of Applied Physics, University of Eastern Finland, Kuopio, Finland. Earlier versions of Kubios HRV has been
described in two scientific publications [19, 28]:

Niskanen J-P, Tarvainen MP, Ranta-aho PO, and Karjalainen PA. Software for advanced HRV analysis. Comp Meth Pro-
grams Biomed, 76(1):73-81, 2004.

Tarvainen MP, Niskanen J-P, Lipponen JA, Ranta-aho PO, and Karjalainen PA. Kubios HRV – Heart rate variability analysis
software. Comp Meth Programs Biomed, 113(1):210-220, 2014.

Kubios HRV is a scientifically validated software and themost commonly used HRV analysis software for scientific
research. This is evidenced by the fact that the two publications listed above have attracted over 1 000 citations.

Kubios HRV is currently available as two alternative products:

KubiosHRVStandard: FreewareHRVanalysis software for non-commercial personal use. SupportsHRdata
from most common HR monitor manufacturers and computes most commonly used time- and frequency-
domain HRV parameters. Software is operated through an easy-to-use GUI and analysis results can be saved
as PDF report or text file.
Product page: https://www.kubios.com/hrv-standard.

Kubios HRV Premium: Full featured HRV analysis software designed for scientific research and profes-
sional use. Supports wide range of ECG, PPG and HR data and computes all commonly used time-domain,
frequency-domain and nonlinear HRV parameters. In addition, Kubios HRV Premium includes improved pre-
processing (beat correction and noise handling), ECG derived respiration, time-varying analysis and extended
exporting options. Analysis results can be saved as illustrative PDF reports, CSV text file, MATLAB MAT file
and also in a ”SPSS friendly” batch file.
Product page: https://www.kubios.com/hrv-premium.

A summary of the features is given in Table 1.

Please visit at https://www.kubios.com/, where you can find current information on the software, download up-
dates, find tutorials and information about HRV and how to use the software. If you have any trouble or ques-
tions regarding the software, please check first if your particular problem or question has an answer in the
FAQ/troubleshooting section at the software homepage! You can also follow us on Facebook, LinkedIn, Twitter,
Instagram and YouTube.

1.2 System requirements

Kubios HRVwas developed usingMATLABr1 and was compiled to a standalone application with theMatlab Com-
piler. Therefore, in addition to Kubios HRV the MATLAB Runtime also needs to be installed. The latest installers
for Kubios HRV and MATLAB Runtime can be downloaded from https://www.kubios.com/download. Please note
that the MATLAB Runtime is free and does not require the user to have a Matlab license. System requirements
for running Kubios HRV are similar to those of Matlab (see https://www.mathworks.com/support/sysreq/) and
only 64-bit operating systems are supported. Please note that correct version of MATLAB Runtime (available at
Kubios download page) must be installed in order to run Kubios HRV.

1MATLABr , The Mathworks, Inc.
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Table 1: Summary of Kubios HRV Standard and Kubios HRV Premium features

FEATURES Standard Premium

Data support
• IBI or RR interval data files: Garmin and Suunto FIT files, Polar TXT files, custom
formatted text and CSV files
• ECG/PPG data files: EDF/EDF+, GDF, Biopac ACQ3, Cardiology XML, ISHNE
Holter ECG, Physionet MIT, and custom formatted text and CSV files

−

• Supported HR monitors: ActiHeart, emWave, Firstbeat Bodyguard, Garmin
(Forerunner and Fenix series), Polar (V800), Suunto (Ambit and Spartan series),
Zephyr BioHarness
+ Direct export from Polar Flow (RR/IBI data from all Polar Flow compatible

monitors when H6, H7 or H10 heart rate sensor is used in measurement)
−

•Supported ECG/PPGdevices: ActiwaveCardio, AliveCor Kardia, Biopac, Bittium
Faros, Empatica E4, Mindfield MindMaster, Shimmer and several clinical Holter
and ECG monitors

−

Pre-processing
• Built-in QRS detector for accurate detection of ECG R-waves and pulse wave
detector for PPG data

−

• Automatic noise detection (automatically identifies noisy ECG/RR data seg-
ments, manual editing also possible)

−

• Beat correction methods: ECG based beat detection corrections / Automatic
beat correction / Threshold based beat correction

− /− / / /

•Smoothness priorsmethod for removing very low frequency trend components
when performing short-term HRV analysis

Analysis options
• Automatic analysis sample generation (based on predefined CSV file) −
• Stress index, PNS index and SNS index
• Time-domain parameters: Mean RR and HR, min/max HR, SDNN, RMSSD,
pNN50, HRV triangular index, TINN etc.
+ HR deceleration (DC) and acceleration capacity (AC) −

• Frequency-domain parameters: VLF, LF and HF band powers (in absolute, rel-
ative and normalised units), peak frequencies and LF/HF ratio
• Spectrum estimation methods: Welch’s periodogram / Lomb-Scargle peri-
odogram / AR spectrum estimate

/− / / /

• Basic nonlinear parameters: Poincaré plot, approximate entropy (ApEn), sam-
ple entropy (SampEn) and detrended fluctuation analysis (DFA)
+ Correlation dimension (D2), recurrence plot analysis (RPA), multiscale en-

tropy (MSE)
−

• Validated algorithm for respiration rate (RESP) estimation from ECG and RR
interval data (useful in reliable RSA component estimation)

−

• Time-varying analysis: instantaneous values for energy expenditure (EE), train-
ing impulse (TRIMP), stress index, PNS/SNS indexes, and all time-domain and
frequency-domain HRV parameters and certain nonlinear parameters. Spectro-
gram with Fire-colormap

−

Reports and results export
•HRV reports (PDF reports) including: time-domain, frequency-domain and non-
linear results / Time-varying analysis results

/− /

• ECG print (PDF report) showing the raw ECG trace for selected time period −
• HRV analysis results export options: PDF file / CSV text file / MATLABMAT file / /− / /
• “SPSS friendly” batch file export (ideal for group analyses or repeatedmeasure-
ments)

−

Windows (7 SP1 or 10, 64-bit) operating system with 4 GB of RAM, 3-5 GB of disk space, screen resolution
of 1024×768 or higher, and the MATLAB Runtime installation.

MacOSX (High Sierra, Mojave or Catalina) operating systemwith 4GB of RAM, 3-5 GB of disk space, screen
resolution of 1024×768 or higher, and the MATLAB Runtime installation

Linux distribution (see qualified distribution at Mathworks site) with 4 GB of RAM, Intel or AMD x86-64 pro-
cessor, 4-6 GB of disk space, screen resolution of 1024×768 or higher, hardware accelerated graphics card
supporting OpenGL 3.3 with 1GB GPU memory, graphical desktop environment, and the MATLAB Runtime
installation.

© 2016-2021 Kubios Oy WWW.KUBIOS.COM
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1.3 Release notes

The version history of the most significant updates and changesmade in Kubios HRV is given in the release notes.
Going though the latest release notes is recommended always before updating to a new version. Up-to-date and
detailed release notes can be found from https://www.kubios.com/release-notes.

1.4 Installation

In order to run Kubios HRV, you need to install Kubios HRV and MATLAB Runtime on your computer. Installers can
be download fromhttps://www.kubios.com/download. The first time you launch Kubios HRV, youwill be prompted
to activate the software for the the current computer using your personal License key. In order to get the License
key, fill in the order form at https://www.kubios.com/. A short description of the installation process at different
operating systems is given below.

Windows: Make sure that you have administrative privileges (you will need them to install Kubios HRV). In
order to install Kubios HRV on aWindows computer, you need to download and run the Kubios HRV installer.
This will install both Kubios HRV and Matlab Runtime on your computer. You can launch Kubios HRV by
using the Desktop icon (if created) or by selecting it from the Start Menu. Please note that Kubios HRV also
starts the MATLAB Runtime and may take some time especially with older computers. The first time you
start Kubios HRV, you also need to activate the software using your personal license key.

Mac OS: Download and run the Kubios HRV installer for macOS (available at our download page). The in-
staller will install Kubios HRV and theMatlab Runtime (NOTE: Matlab Runtime will be downloaded during the
installation process only if it is not found from your computer) into separate folders under your Applications.
To start Kubios HRV, you need to click the Kubios HRV application under the KubiosHRV folder in your Ap-
plications. You can also find Kubios HRV application with Spotlight (click � on the upper-right corner of the
menu bar or press Command+Space). NOTE: If you have an earlier version of Kubios HRV software installed
in your Mac, we recommend that you uninstall the older version first (move the installed Kubios HRV and
earlier version of Matlab Runtime to trash).

Linux: Install the MATLAB Runtime by extracting the MATLAB Runtime zip package and executing the in-
staller command ./install as root. Do not change the default MATLAB Runtime install directory if you do
not have a special need to change it. Kubios HRV assumes that MATLAB Runtime is installed in the default
directory. Otherwise the MATLAB Runtime directory has to be given as an argument to the run_kubioshrv
script. Kubios HRV can be installed using the deb (Ubuntu/Debian) or rpm (Fedora/SUSE/RedHat) package
using your packagemanager. Furthermore, Kubios HRV can also be installed without a packagemanager by
extracting the tar.gz file to a directory of your choosing. To run Kubios HRV, select it from the menu of your
desktop environment or run the command kubioshrv-standard or kubioshrv-premium in the terminal. If
you have installed Kubios HRV using the tar.gz package, go to the directory you extracted the package and
run ./run_kubioshrv in the terminal.

1.5 Uninstallation

Windows: The software can be uninstalled using the ”Windows Settings > System > Apps & Features” (Win-
dows 10) or ”Control Panel > Programs and Features” (Windows 7 SP1). However, the uninstaller does not
remove your preferences settings or license file. These have to be deleted manually and can be found in the
following folders:

Kubios HRV Standard
C:\Users\<username>\AppData\Roaming\Kubios\KubiosHRVStandard
C:\ProgramData\Kubios\KubiosHRVStandard
Kubios HRV Premium
C:\Users\<username>\AppData\Roaming\Kubios\KubiosHRVPremium
C:\ProgramData\Kubios\KubiosHRVPremium

Mac OS: Move the installed applications (MATLAB Runtime and Kubios HRV application) to trash.

© 2016-2021 Kubios Oy WWW.KUBIOS.COM
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Linux: Remove theMATLABRuntimeby deleting the directory it was installed in (default /usr/local/MATLAB/MATLAB_Runtime/v91).
If you have installed Kubios HRV using a deb or rpm package, use your package manager to uninstall the
kubioshrv package. If you have installed Kubios HRV using the tar.gz package, just delete the directory it
was extracted in. However, the preferences and license file have to be deleted manually from the ~/.kubios
directory.

2 Supported data formats and devices

The different file formats and devices that are compatible with Kubios HRV are described here. Features available
only in the Premium version are indicated in the text and an overview of differences between these versions is
given in Table 1.

Kubios HRV supports the following data formats:

1. Polar TXT and HRM files (Polar Electro Ltd.) (*.txt,*.hrm)
2. Suunto FIT files (Suunto Ltd.) (*.fit)

Suunto SDF, STE and XML files (older formats) (*.sdf,*.ste,*.xml)
3. Garmin FIT files (Garmin Ltd.) (*.fit)
4. RR interval text files (*.txt,*.dat,*.csv)
5. Custom text data files (only RR data) (*.txt,*.dat,*.csv)

Available only in Premium version:
6. Direct export from Polar Flow (in FIT format) (*.fit)
7. ECG and PPG data text files (*.txt,*.dat,*.csv)
8. Custom text data files (RR, ECG and PPG data) (*.txt,*.dat,*.csv)
9. Biopac ACQ3 files (Biopac Systems Inc.) (*.acq)
10. Cardiology XML files (*.xml)
11. European data format (EDF and EDF+) files (*.edf)
12. General data format (GDF) files (*.gdf)
13. ISHNE Holter ECG data format files (*.ecg)
14. Physionet MIT files (*.hea, *.dat)
15. Zephyr BioHarness ECG and RR data files (*.csv)

16. Kubios HRV Matlab MAT files (*.mat)

When using Polar, Suunto or GarminHRmonitors,make sure that your device canmeasure and store RR intervals
in beat-to-beat. From averaged data (e.g. HR values at every 5 seconds) you are not able to analyse HRV. In
addition to standardized HR monitor file formats, a support for plain RR interval text files (ASCII files) is provided.
The input text file can include RR interval values in one or two column format, i.e. the RR interval values can be
given as:

Type 1 Type 2

0.759 0.759 0.759
0.690 1.449 0.690
0.702 2.151 0.702
0.712 2.863 0.712
0.773 3.636 0.773

...
...

...

In Type 2 format, the first column includes the time indexes of Rwave detections (zero time for the first detection in
this example) and second column the RR interval values. The RR interval values above are given above in seconds,
but also millisecond values can be used.

Similarly, ECG data can be given as input in text file formatted as shown below

© 2016-2021 Kubios Oy WWW.KUBIOS.COM
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Type 1 Type 2

-0.173 0 -0.173
-0.119 0.002 -0.119
-0.025 0.004 -0.025
0.091 0.006 0.091
0.218 0.008 0.218

...
...

...

where the first column on Type 2 format is the time scale in seconds for the ECG data. The sampling rate of this
example file is thus 500 Hz (samples per second). If ECG data is given according to the Type 1 format, user is
prompted to enter the sampling rate manually.

In addition to above text file formats, a custom text file option is also provided. Using this option you can import
text files including header lines and/or several data columns. Once you have selected an input file, an interface for
importing the file into Kubios HRV is opened. This interface and the options that you need to set according to your
data file are shown in Fig. 1.

Options to be set based on the data file:
• Number of header lines
• Column separator (tab/space, comma, or semi-
colon)
• Data type (ECG, PPG, RR or Beat times)
•Data column (the ordinal number of data column)
• Data units (µV, V or mV for ECG / ms or s for RR)
• Time index column (the ordinal number of time
indexes)
• Time units (units of time indexes in ms, s or
date/time format)
• ECG sampling rate in Hz (if no time index column
is defined for ECG)
• Additional inputs: measurement date and time
subject name, age, gender, rest HR,maxHR, Height
and weight
• Signal preview (to help finding the correct set-
tings to read the data file).

Once you have specified the above values for your
file, press OK to proceed to opening the file.

Figure 1: The interface for importing custom text data files into Kubios HRV.

In addition to above text file formats, Kubios HRV supports the Zephyr BioHarness file format (CSV file), Cardiology
XML, and five binary data formats (Biopac ACQ3, EDF, GDF, ISHNE ECG, adn Physionet MIT). The EDF/EDF+ are
open file formats quite generally used for storing biomedical signal data. The ISHNE ECG is a standard output
format for Holter ECG data described in [1]. When any of these binary files are read to the software, Kubios HRV
automatically tries to determine the ECGchannel from the channel labels. If the ECGchannel cannot be determined
(ormore than one channels are identified as ECGchannels), the software prompts the user to select the appropriate
channel.

A list of commonly used devices, which are known to be compatible with Kubios HRV is given in Table 2. Please
note that this is not a complete list, many other devices may also support exporting the data in Kubios HRV com-
patible format.

Finally, the software supports also MATLAB MAT files saved by Kubios HRV. When you are using Kubios HRV, you

© 2016-2021 Kubios Oy WWW.KUBIOS.COM
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can save the analysis session into a MATLAB MAT file as described in Section 5.3. The MAT files include all the
analysis results and settings as well as the raw data (ECG, PPG or RR data). Therefore, you are able to reopen the
analysis session by opening the saved MAT file again in Kubios HRV.

Table 2: Commonly used ECG or HR measurement devices known to be compatible with Kubios HRV.

Devices Data type Kubios HRV input option
Actiheart (CamNtech Ltd.) IBI RR text file
Actiwave Cardio (CamNtech Ltd.) ECG EDF
Biopac system with ECG module (Biopac Systems Inc.) ECG Biopac ACQ3
Cortium C3** (Cortrium Ltd.) ECG EDF
Faros (Bittium) ECG/IBI EDF
Empatica E4 (Empatica Inc.) PPG Custom text file
emWave (HeartMath Inc.) IBI Custom text file
Firstbeat Bodyguard (Firstbeat Technologies Ltd.) IBI SDF file
Garmin (Forerunner and Fenix) HRmonitors* (Garmin Ltd.) IBI FIT file
GE CardioSoft and CASE systems (GE Healthcare) ECG Cardiology XML
Kardia** (AliveCor Inc.) ECG EDF
Mindfield MindMaster (Mindfield Biosystems Ltd.) ECG EDF
Polar HR monitors* (Polar Electro Ltd.) IBI FIT file or HRM/RR text file
Shimmer ECG and PPG systems (Shimmer Sensing) ECG/PPG Custom text file
Suunto (Ambit and Spartan) HR monitors* (Suunto Ltd.) IBI FIT/SDF/STE/XML files
Zephyr BioHarness (Zephyr Tech. Corp.) ECG/IBI Zephyr BioHarness CSV
* Make sure that the model supports beat-to-beat data export (IBI data). A direct export from Polar Flow
is available in Premium version (supports any Polar Flow compatible monitor with H6, H7 or H10
heart rate sensor).
** Requires converter available from device manufacturer

© 2016-2021 Kubios Oy WWW.KUBIOS.COM
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3 Beat detection and pre-processing

3.1 Beat detection algorithms

Kubios HRV Premium has a built-in accurate QRS and pulse wave detectors for detecting heart beats from ECG
and PPG data, respectively.

In case ECG data is imported into Kubios HRV Premium, the R-wave time instants are automatically detected
by applying the built-in QRS detection algorithm. This in-house developed detection algorithm is based on the
Pan–Tompkins algorithm [22]. The detector consists of a preprocessing part followed by decision rules. The pre-
processing part includes bandpass filtering of the ECG (to reduce power line noise, baseline wander and other
noise components), squaring of the data samples (to highlight peaks) and moving average filtering (to smooth
close-by peaks). The decision rules include amplitude threshold and comparison to expected value between adja-
cent R-waves. Both of these rules are adjusted adaptively every time a new R-wave is acceptably detected. Before
R-wave time instant extraction, the R-wave is interpolated at 2000 Hz to improve the time resolution of the detec-
tion. This up-sampling will significantly improve the time resolution of R-wave detection when the sampling rate
of the ECG is relatively low (200 Hz or higher recommended).

The pulse wave detector is based on matched filtering approach. Firstly maximum of 1st derivative representing
the steepest part of the pulse wave is used for initial pulse location estimation. Secondly, template for the pulse
wave (and matched filter) is constructed using the initial pulses. Decision of the final pulse wave locations are
defined by comparing the filtered signal against varying threshold and comparing normalized error between the
template and PPG signal. Allowed normalized error between template and pulse wave under inspection can be
adjusted in software preferences. That is, the smaller the acceptance threshold percent is the more similar the
pulse wave have to be with the template in order to be accepted.

The accuracy of the pulse wave detection algorithm is shown in Fig 2. The left panel showing the Bland-Altman
plot illustrating the agreement between detected PP intervals and corresponding RR intervals during a resting
measurement. The right panel shows error percentages of commonly used HRV parameters estimated from PP
interval compared to RR interval time series. Used dataset contains 20 healthy volunteers with wide age scale (20
to 50 years). Error between the RR and PP time series is -0.01±5.16 ms (mean ± SD). This ±5 ms error in heart
beat detection produces approximately ±10% maximum errors to the HRV parameters.

Figure 2: Accuracy of the PP interval vs. RR interval during restingmeasurement is presented on left panel. In right
panel, errors between the PRV and HRV parameters are presented. Blue box indicates region between the 25-75
percentile and black lines are maximum and minimum value.

3.2 Noise segments

KubiosHRVPremiumsoftware supports automatic noise detection, which automatically identifies noise segments
based on the raw ECG data (if available) and from the interbeat interval data (RR or pulse-to-pulse intervals). The

© 2016-2021 Kubios Oy WWW.KUBIOS.COM
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noise detection level can be changed between Very low, Low, Medium and Strong (default Medium) and you can
turn it off by switching it to None “level”. Automatic noise detection is extremely helpful for those analyzing long-
term ambulatory ECG or RR recordings, where signal quality is not good throughout the recording. Please note
that noise detection aims to identify noise segments which distort several consecutive beat detections, and thus,
would affect on HRV analysis accuracy. Individual intermittent abnormal beat intervals (e.g. ectopic beats) are
not typically marked as noise, since these can be reliably corrected by the automatic beat correction (which is
by default performed after noise detection). All segments marked as noise will be excluded from HRV analysis.
Please note that you can also manually edit the noise segment markings if necessary, see Fig. 3.

Figure 3: Illustration of noise segment markings in Kubios HRV Premium software. Noise segments can be man-
ually edited from ECG or RR data axes with mouse (right-click to remove an existing noise marking, CTRL + left
mouse button (Win) or Command + left mouse button(macOS) to mark/unmark noise).

3.3 Artefact correction algorithms

Artefacts in the IBI time series can cause significant distortion toHRVanalysis results, and thus, all artefacts should
be either corrected or excluded fromanalysis as recommended also in [30]. Typical artefacts includemissing, extra
or misaligned beat detections as well as ectopic beats such as premature ventricular contractions (PVC) or other
arrhythmias.

Kubios HRV includes two methods for correcting artefacts and ectopic beats present in the IBI data: 1) Threshold
based correction, in which the artefacts and ectopic beats are simply corrected by comparing every RR interval
value against a local average interval; 2) Automatic correction (only available in Premium), in which artefacts are
detected from a time series consisting of differences between successive RR intervals. The automatic correction
is more accurate and the method has been validated in [14]. In addition to these IBI data based correction
methods, the beat detections can be corrected manually when ECG data is used for analysis (see Section 4.2).

The threshold based artefact correction algorithm compares every IBI value against a local average interval. The
local average is obtained bymedian filtering the IBI time series, and thus, the local average is not affected by single
outliers in IBI time series. If an IBI differs from the locale averagemore than a specified threshold value, the interval
is identified as an artefact and is marked for correction. The threshold value can be selected from:

• Very low: 0.45 sec (threshold in seconds)

• Low: 0.35 sec

• Medium: 0.25 sec

• Strong: 0.15 sec

• Very strong: 0.05 sec

• Custom, for setting a custom threshold in seconds
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For example, the “Medium” correction level will identify all IBIs that are larger/smaller than 0.25 seconds compared
to the local average. The correction is made by replacing the identified artefacts with interpolated values using
a cubic spline interpolation. Please note that the thresholds shown above are when 60 bpm hear rate and are
adjusted according to mean heart rate (i.e. lower thresholds for higher heart rate). The correction level should be
adjusted individually, because inter-individual difference in HRV are quite significant and therefore a fixed threshold
does not work optimally for all subjects. The optimal threshold is the lowest correction level which identifies all
artefacts but does not identify too many normal RR intervals as artefacts.

In the automatic artefact correction algorithm, artefacts are detected from dRR series, which is a time series
consisting of differences between successive RR intervals. The dRR series provides a robust way to separate
ectopic and misplaced beats from the normal sinus rhythm. To separate ectopic and normal beats, time varying
threshold (Th) is used. To ensure adaptation to different HRV levels, the threshold is estimated from the time
varying distribution of the dRR series. For each beat, quartile deviation of the 90 surrounding beats is calculated
and multiplied by factor 5.2. Beats within this range cover 99.95% of all beats if RR series is normally distributed.
However, RR interval series is not often normally distributed, and thus, also some of the normal beats exceed the
threshold. Therefore, decision algorithm is needed to detect artefact beats.

Ectopic beats formnegative-positive-negative (NPN) or positive-negative-positive (PNP) patterns to the dRR series.
Similarly long beats form positive-negative (PN) and short beats negative-positive (NP) patterns to the dRR series.
Only dRR segments containing these patterns are classified as artefact beats. Missed or extra beats are detected
by comparing current RR value with median of the surrounding 10 RR interval values (medRR). A missed beat is
detected if current RR interval (RR(i)) satisfies condition∣∣∣∣RR(i)

2
−medRR(i)

∣∣∣∣ < 2Th (1)

and an extra beat is detected if two successive RR intervals (RR(i) and RR(i+1)) satisfy condition

|RR(i) +RR(i+ 1)−medRR(i)| < 2Th. (2)

Detected ectopic beats are corrected by replacing corrupted RR times by interpolated RR values. Similarly too long
and short beats are corrected by interpolating new values to the RR time series. Missed beats are corrected by
adding new R-wave occurrence time and extra beats are simply corrected by removing extra R-wave detection and
recalculating RR interval series.

3.4 IBI time series trend removal

Another common feature that can alter the analysis significantly are the slow linear or more complex trends within
the analysed time series. Such slow nonstationarities are characteristic for HRV signals and should be considered
before the analysis. The origins of nonstationarities in HRV are discussed, e.g., in [4]. Two kinds of methods have
been used to get around the nonstationarity problem. In [32], it was suggested that HRV data should be system-
atically tested for nonstationarities and that only stationary segments should be analysed. Representativeness of
these segments in comparison with the whole HRV signal was, however, questioned in [10]. Other methods try to
remove the slow nonstationary trends from theHRV signal before analysis. The detrending is usually based on first
order [15, 17] or higher order polynomial [25, 17] models. In addition, Kubios HRV software includes an advanced
detrending method originally presented in [29]. This method is based on smoothness priors regularisation and is
suitable also for more complex trends of the time series. The method works like a time-varying highpass filter,
smoothing the data according to the value of the smoothing parameter. The bigger the smoothing parameter is
the lower is the cutoff frequency of the filter. We recommend using the smoothness priors method for removing
IBI time series nonstationarities. The cutoff frequency should be below the low frequency band (< 0.04 Hz) not to
remove any parts of the normal short term HRV.
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4 Kubios HRV user interface

In this section, the graphical user interface (GUI) of Kubios HRV analysis software explained. Please note that
functionalities available in the GUI depend on the version you are using (Standard or Premium). All the screen cap-
tures shown in this documentation are taken from the Kubios HRV Premium. Features available only in Premium
are mentioned in the text.

The user interface window of Kubios HRV is shown in Fig. 4. The user interface is divided into three segments:
1) the RR interval series options segment on the top left corner, 2) the data browser segment on the top right
corner, and 3) the results view segment on the bottom. These segments are described in Sections 4.1, 4.2 and 4.3,
respectively.

Figure 4: The graphical user interface of Kubios HRV analysis software.

4.1 RR interval series options

The RR interval series options shown in Fig. 5 includes three functions: 1) Noise segments, 2) Beat correction, and
3) Samples for analysis. Noise segment options can be used to mark time periods where data is too noisy to be
analyzed. You can adjust the automatic noise detection level (the default level can be changed from preferences)
and you can also manually edit noise segment markings. Time periods marked as noise are excluded from HRV
analysis (see Section 3.2). The beat correction options can be used to correct artifacts from a corrupted RR
interval series. The user can select between two methods: 1) Automatic correction (available only in Premium)
and 2) Threshold correction. The automatic correction is an accurate algorithm for detecting artifacts (missed,
extra and misaligned beat detections) as well as ectopic beats. The threshold correction simply compares every
beat interval against a local mean RR, and identifies the beat as artifact if it exceeds the specified threshold. The
threshold should be selected individually, because normal variability in RR intervals can be quite different between
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individuals, and therefore, a fixed threshold could over or under correct the RR data. For details on these correction
algorithms, see Section 3.3.

Figure 5: The RR interval series options segment of the user interface.

When using any of the beat correctionmethods, Kubios HRV displays on the RR data axis the corrected RR interval
time series in blue and original uncorrected data in light grey as shown in Fig. 6 A. In this case, the RR interval data
includes two clear artifacts: 1) a simulated ectopic beat at 10:13:40 (short interval followed by longer interval)
and 2) a simulated missed beat detection at 10:15:30, which are both nicely corrected by using the automatic
correction. The number of corrected artifacts in the whole recording is given under the Artifact correction controls
and the number of artifacts corrected from the analysis sample is given under Samples for analysis controls. A
piecewise cubic spline interpolation method is used in the corrections.

The importance of artifact correction is highlighted in Figs. 6 B-C. Please observe that having only two artifacts
within the 5-min analysis segment has a significant effect on the time-domain HRV parameters, especially on
SDNN, RMSSD and TINN. Thus, even single artifacts should always be either corrected or excluded from analysis.
On the other hand, the number of corrected beats should not be too high (preferably <5%) not to cause significant
distortion (suppressed variability) to analysis results. Finally, if ECG is measured, you should first try to directly
correct the R-wave detections shown in the ECG data axis as described in Section 4.2.

Using the Samples for analysis options, you can add as many analysis samples that you want (the number of
samples is not limited) and you can easily modify the positioning and length of these samples. You can edit the
samples using the Add (adding a new sample), Remove (removing the active sample), Start (changing sample
onset), Length (changing sample length), Sample Label (an illustrative name for the sample), and Sample Color
(e.g. color-code different types of samples) controls. In addition, you can also edit the samples using mouse
directly on the RR data axis as described in Section 4.2. Sample Label and Color are optional. By default, Kubios
HRV computes analysis results for every selected sample, but you can also choose to merge all samples into one
longer sample before analysis using the Sample analysis type control under the RR data axis.

NOTE: In Kubios HRV Premium, you can automatically generate analysis samples by editing desired sample infor-
mation within a structured CSV file (”Kubios_Samples.csv” found from the Sample Data folder). In the CSV file
you can can define Sample Label, Color, Start time and End time for as many samples as necessary. Analysis
samples can be defined differently for every file in the folder or you can also define general sample definitions that
will be used for every file in the folder. More information about editing the CSV file is provided on the file header.
If the CSV file is placed in the same folder with the data files and sample definitions for a given data file are found,
the analysis samples will be automatically imported into Kubios HRV. This feature will make analysis of larger data
sets with known sample times much easier.

4.2 Data browser

The data browser segment shown in Fig. 7 displays the measured ECG signal and the extracted RR interval series.
If RR interval data is given as input (no ECG data), then only the RR data axis will be displayed in a bigger size. The
ECG and RR interval data axes can be controlled by using Sliders (scrolling the data), Range edit boxes (to change
data range shown on the axes), and Y-limit edit boxes (to change the y-axis scaling). The range of the ECG axis is
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A) RR artifact correction in Kubios HRV

B) Without artifact correction C) Artifacts corrected

Figure 6: RR interval artifact correction. A) The artifact corrected series is visualized on top of the raw RR interval
series, summary of corrected beats within the recording is given on the right side of RR data axis. Time-domain
analysis results B) before artifact correction and C) after the artifacts have been corrected.

displayed as a grey patch on the RR axis, which can be moved with left mouse button. ECG and RR axes can also
be locked (Lock toggle button) and scrolled together.

Figure 7: The data browser segment of the user interface.

The main functionalities of the data browser segment are described below.
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Correcting beat detections – If ECG (or PPG) data is available, each detected beat is marked in the ECG (or
PPG) axis with a “+” mark. Beat detection markers can be easily edited using the tools on the right hand side
of the ECG (or PPG) axis. The button actions (from top to bottom) are as follows:

– Turn on/off the beat detection editing mode. When editing beat detections, HRV analysis results are
not updated (auto-refresh results turned off) to guarantee smooth editing. When exiting the beat editing
mode, any changes made in beat detection become effective and analysis results are updated accord-
ingly.

– Add (shortcut ”a”) beat detection markers for missed beats.
– Adjust beat detection marker snapping window width (shortcut SHIFT+Scroll) when in Add mode.
– Move/shift (shortcut ”s”) existing beat detection markers for misaligned beat detections.
– Remove/delete (shortcut ”d”) beat detection markers for extra beat detections.

Data markers – Event markers stored in the recording (if any) are shown both at top of ECG (or PPG) and
RR interval data axes as small black triangles. On mouse-over, the text of the marker is displayed. Analysis
samples snap to event markers, to ease-up analyzing the data according to available markers. By clicking
the ” ” button on the right, you can choose which markers are displayed.

RR data plot options – From the right side of the RR interval axis, you choose if the data axes shows RR
interval or HR values, and if the data is plotted as a dotted line or normal line (” ”). Also, from the button
on top-right corner, you can choose to enlarge the RR data axis.

Mouse gestures/shortcuts

– Pan (scroll, SHIFT + scroll) and zoom (Win: CTRL + scroll, maxOS: Command + scroll) data on RR and
ECG data views by using mouse scroll wheel.

– Pan both RR and ECG data views by dragging with middle mouse button.
– Add a newanalysis sample or noise segment (Win: CTRL + leftmouse button + drag, macOS: Command

+ left mouse button + drag).
– Delete analysis sample or noise marking, or duplicate an analysis sample (right click to open menu).
– Move or resize analysis samples by dragging themwith leftmouse button from themiddle of the sample

(to move) or from the left or right edge (to resize).
– Center ECG data view to current cursor position in RR data view (Shift + left mouse click).

4.3 Results view

The results for the selected RR interval sample are displayed in the results view segment (see Fig. 4, which shows
results for a maximal cardiopulmonary exercise test). The results are divided into 1) Overview, 2) Time-domain,
3) Frequency-domain, 4) Nonlinear, and 5) Time-varying (available only in Premium) categories. The results of
each category are displayed by pressing the corresponding button on the top of the results view segment. The
results are by default updated automatically whenever analysis samples or analysis settings are changed. The
processing time for computing all the analysis results depends on the length of measurement and number of
analysis samples. If the updating of the results takes too much time, you can disable the automatic update by
unchecking the ”Auto-refresh results” check box on top of the results view segment. When unchecked, you can do
all the changes to the analysis samples and settings at once, and then press the ”Refresh” button when you want
to update the results.

4.3.1 Results overview

The results overview section shown in Fig. 8 displays 1) a comparison between HRV parameters of selected analy-
sis segment and normal resting values and 2) an overview of recording. The normal values for the HRV parameters
(Mean RR, Mean HR, RMSSD, SD1 (%) and SD2 (%)) are obtained or derived from the quantitative systematic re-
view by Nunan et al. 2010 [20]. The Stress index is the square root (to make the index normally distributed) of the
Baevsky’s stress index proposed in [2] and values of Baevsky’s stress index between 7 and 12 are considered nor-
mal. The six HRV parameters divided into those reflecting paramsympathetic nervous system (PNS) tone (Mean
RR, RMSSD and SD1 (%)) and those reflecting sympathetic nervous system (SNS) tone (Mean HR, Stress index
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and SD2 (%)) are illustrated on top of the normal value distributions. These graphs give a quick view about the
level of subject’s HRV with respect to normal values. NOTE: the normal values are from rest measurements, thus
exercise or stressful situations are expected to produce higher heart rate and lower HRV. PNS and SNS indexes
are computed to provide an overall measures of these nervous system activities as compared to normal resting
values.

Figure 8: Results overview segment of Kubios HRV.

The overview of the recording includes an illustration of HR, PNS index and SNS index time trends; HR zones graph
(time spent in each zone); PNS index zones (time spent in each zone); and energy expenditure (basal metabolic
rate and activity related energy expenditure). These information are also provided in the time-varying report sheet
(see Section 5.2), where also SNS index zones are illustrated. HR, PNS index and SNS index zones are defined as
follows:

HR zones PNS zones SNS zones
(of HRmax)

MAXIMUM: 90–100% VERY LOW: < −2 VERY HIGH: > 2
HARD: 80–90% LOW: −2 . . .− 1 HIGH: 1 . . . 2
MODERATE: 70–80% NORMAL: −1 . . . 1 NORMAL: −1 . . . 1
LIGHT: 60–70% HIGH: 1 . . . 2 LOW: −2 . . .− 1
VERY LIGHT: 50–60% VERY HIGH: > 2 VERY LOW: < −2
INACTIVE: <50 %

The total energy expenditure is divided into 1) Basal metabolic rate (BMR) and 2) Activity related energy expendi-
ture (EE). Energy expenditure (EE) is computed using the Keytel’s model without a measure of fitness (VO2,max)
according to [13]. The BMR is estimated using the Mifflin-St Jeor equations [16], which have been found to be
the most accurate. The energy expenditure computations are based on heart rate, body weight, height and age,
which can be defined in Preferences. In Kubios HRV Premium, these settings can also be changed by clicking the
Change Personal Data button (to enable a quick way to update personal details for the current recording).

In Premium version, in addition to energy expenditure, training impulse (TRIMP) is also computed. The TRIMP is
computed according to exponential Banister’s model [18]. Both EE and TRIMP are computed using beat-to-beat
HR values, and thus, their instantaneous values (EE in kcal/min and TRIMP/min) can be reliably derived and these
are reported at time-varying results.

4.3.2 Time-domain results view

The time-domain results view shown in Fig. 9, displays the time-domain HRV parameters in a table on the left. The
two figure on the right show the RR interval histogram andHR deceleration capacity (DC) and acceleration capacity
(AC) graphs. All HRV parameters are calculated from the detrended RR interval data (if detrending is applied), but
mean RR, mean HR as well as min and max HR values are exceptions (marked with the ∗ symbol). In the edit
boxes below the RR histogram, you can define fixed lower and upper limits for RR values. These limits are saved
in software preferences, so you only need to enter them once. These limits have effect on how the RR histogram
is displayed, not only in the results view segment but also in the report figure described in Section 5.2. If you leave
the edit boxes empty, the histogram is auto-scaled according to the minimum and maximum values of the data.
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Figure 9: Time-domain HRV analysis results view of Kubios HRV software.

4.3.3 Frequency-domain results view

The frequency-domain results view shown in Fig. 12, displays the results for both FFT and AR spectrum estimation
methods. Both methods are applied to the detrended RR series. The spectra of the two methods are presented
in the two axes (FFT spectrum on the left and AR spectrum on the right). In Premium version, user can choose
in software preferences (see. Section 6) to use Lomb-Scargle periodogram instead of FFT based Welch’s peri-
odogram. The frequency axes of the spectra are fixed to range from 0 Hz to the upper limit of HF band plus 0.1 Hz.
Thus, for the default frequency band settings the frequency axis range is 0–0.5 Hz. The results for both spectra
are displayed in the table on the left. An estimate of respiration rate (RESP) is also computed from the ECG (if
available) and RR data. Respiration rate is shown as a vertical line in both spectrum estimates and the numeric
value is shown below the spectrum Y-limit options.

Figure 10: Frequency-domain HRV analysis results view of Kubios HRV software.

The frequency-domain results view includes the following settings. The power axes limits, can be adjusted with
the options below the spectrum axes. The power axes can be selected to have either common (same limits for
FFT/Lomb and AR spectra) or separate upper Y-limits. If common Y-limit is selected, it can also be entered manu-
ally into the edit box beside the selection button. The selected power axis options apply also for the report sheet.
Below the spectrum Y-limits options, there is a checkbox, which can be used to show/hide the respiration rate
(RESP). In addition, you can find settings for the very low frequency (VLF), low frequency (LF), and high frequency
(HF) bands limits. The default values for the bands are VLF: 0–0.04 Hz, LF: 0.04–0.15 Hz, and HF: 0.15–0.4 Hz
according to [30]. The default values for the bands can be restored by pressing the Defaults button. Adjustments
to the frequency bands here apply only for the current session, if you want to change these settings permanently,
you need to do it by editing software preferences (see Section 6).

4.3.4 Nonlinear results view

Thenonlinear results viewshown in Fig. ??, displays all the calculated nonlinear variables in one table. ThePoincaré
plot and the DFA results are also presented graphically in the two axes. In the Poincaré plot (left hand axis), the
successive RR intervals are plotted as blue dots and the SD1 and SD2 variables obtained from the ellipse fitting
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technique are presented. In the DFA plot (right hand axis), the detrended fluctuations F (n) are presented as a
function of n in a log-log scale and the slopes for the short term and long term fluctuations α1 and α2, respectively,
are indicated.

Figure 11: Nonlinear HRV analysis results view of Kubios HRV software.

4.3.5 Time-varying results view

The time-varying results view shown in Fig. ??, displays the time-varying trend of the selected variables. Time-
varying analysis is by default applied to the whole measurement, but you can also change Preferences to perform
time-varying analysis for every analysis sample (see Section 6). You can either view two selected HRV variables
or the time-varying spectrum. Selected variables are plotted in the right hand side axis (plot style can be changed
between line plot and filled patch plot from the toggle buttons). You can also choose if you want a background grid
and data point markers to be plotted (checkboxes below variable selections). When the time-varying spectrum is
selected for view, a color bar indicating the power values is also shown on the right. The colormap of the spectrum
can be changed with the Color map dropdown button. The adjustable options for the time-varying analysis include
the window width and grid interval for the moving window, which is used to calculate the results.

Figure 12: Time-varying HRV analysis results view of Kubios HRV software.

4.4 Menus and toolbar buttons

The user menus and toolbar buttons are located on the upper left hand corner of the user interface. There are all
together four usermenus and eight toolbar buttons. The toolbar button icons and their actions are explained below

Open new data file button is for opening a new data file for analy-
sis. If the results of the current analysis have not been saved, user is
prompted to do so.
Save results button is for saving the analysis results. The results can
be saved in ASCII, PDF, and MATLAB MAT file format (see Section 5
for details).
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Append results to ”SPSS friendly” batch file (available only in Pre-
mium) button is for adding the current analysis session results into
an existing (or creating a new) ”SPSS friendly” batch file (see Section
5 for details).
Print results button is for printing the current results without opening
report sheet windows.
Report preview button opens the report sheet preview window which
include all the analysis results (see Section 5.2 for details).
Edit preferences button opens a preferences window in which you
can, e.g., change the default values for analysis options (see Section
6 for details).
About Kubios HRV button opens the about dialog of the software,
which includes the version number and contact information. Also the
Kubios HRV End User License Agreement can be viewed in the about
dialog.

Zoom in/out buttons can be used to zoom in or out on the ECG
and RR data axes (please note that in other axes zooming is
not enabled).

Close file button closes the current data file. If the results of the cur-
rent analysis have not been saved, user is prompted to do so.
Show/hidemarkersbutton toggles between showing andhiding event
marker time points over the ECG and RR axes.
Show/hide marker lines button toggles between showing and hiding
event marker vertical dashed lines over the ECG and RR axes.

All the above actions are also available on the user menus. The File menu includes Open, Save Results, Save Re-
sults As, Append Results to ”SPSS friendly” Batch File, Print Results, Edit Preferences, Close, and Quit commands.
The Quit command of the File menu is for exiting from the software. The File menu also displays the last nine
opened data files. The Viewmenu includesMarkers menu, Display ECG/PPG printout preview (an example of ECG
printout is shown in Fig. 20), and Report preview command. The Markers menu is for displaying possible stimuli
or event markers presented in the experimental procedure and stored in the data file. If no markers are found from
the data file theMarkersmenu will be disabled. The Tools menu includes Polar Flow Export option, which provides
an easy way to export all your Polar Flow measurements into your computer in FIT file format to be analyzed in
Kubios HRV (see Appendix A for details). Finally, the Help menu includes links to Kubios HRV User’s guide, Kubios
home page, Kubios Support pages, Contact us by e-mail, License information, and the About Kubios HRV dialog.

5 Saving the results

The analysis results can be saved by selecting Save Results or Save Results As from the File menu or by pressing
the save button on the toolbar. This will open a file save dialog in which the saving type can be selected. There are
three different types in which the results can be saved: 1) the results can be written in an ASCII text file for further
inspection, 2) the report sheets generated from the results can be saved in a PDF-file, and 3) the results can be
saved in a MATLAB MAT-file (available only in Premium). In addition to these, Kubios HRV Premium includes the
Append to ”SPSS friendly” batch file option to save session results into existing batch file (ideal for saving group
results).

5.1 ASCII text file

When the ASCII text file is selected for the saving type, the numeric results of the analysis will be written in an CSV
formatted text file. The resulting text file includes the following information in the enumerated order.

1. Software, user, and data file informations
2. Used analysis parameters
3. Samples selected for analysis
4. Results overview
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5. Time-domain results
6. Frequency-domain results
7. Nonlinear results
8. Time-varying results
9. RR interval data and spectrum estimates

The columns of the file are separated with comma or semicolon (can be adjusted in software preferences) so
that the results could easily be imported to, e.g., spreadsheet programs such as the Microsoft Excelr for further
inspection. A preview of the CSV formatted text file showing standard analysis results is presented in Fig. 21 and
showing time-varying results in Fig. 22.

5.2 PDF report

The PDF report includes all the analysis results for the current session. The report pages opens in a preview
window where they can be easily printed or saved into a PDF file. Kubios HRV produces one report page for every
analysis sample including all the time-domain, frequency-domain, and nonlinear analysis results as shown in Fig.
23. In addition, Kubios HRV Premium produces one page (or several pages if time-varying analysis has been set
to apply into analysis samples in Preferences) including time-varying analysis results as shown in Fig. 24. The RR
interval data and the sample selected for analysis are presented on top of all report pages and the analysis results
below them.

When Save Results have been selected, the report page(s) can be saved in a single PDF-file by selecting Report
figure as the saving type in the save dialog. In this case, the report page(s) will not be displayed, but just saved in
the selected PDF-file. If you wish to view the report page(s), choose Report preview from the View menu or just
press the corresponding toolbar button.

The report preview window includes 11 toolbar buttons and File and Page menus on the upper left hand corners
of the windows. The toolbar buttons are explained below

Print button opens a print dialog from which the report page(s) (all
pages, pages in certain range or current page) can be sent to the se-
lected printer.
Save all pages as PDF-file button is for saving all report page(s) into
a single PDF-file.
Zoom in button if for zooming in (magnifying) the report page.

Zoom out button is for zooming out the report page.

Reset to original size button can be used to restore the original zoom
level. This also resets the size of the corresponding report preview
window to its original size.

Move visible area button is for moving the visible area of the zoomed
report page in the report preview window (just grab the sheet with
mouse and drag it to the desired direction).
Close button is for closing the report preview.

Go to first page button is for displaying the first report page in the
preview.
Go to previous page button is for displaying the previous report page
in the preview.
Go to next page button is for displaying the next report page in the
preview.
Go to last page button is for displaying the last report page in the pre-
view.

The File menu includes Save All Pages as PDF, Print and Close commands, which are also given as toolbar buttons
described above. The Page menu includes commands for changing the page that is displayed in the preview
window (First page, Previous page, Next page, Last page), which are all also given as toolbar buttons.
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5.3 Matlab MAT-file (available in Premium)

In addition to saving the numeric results into an ASCII text file or saving the report sheet(s) in a PDF-file, the analysis
results can also be saved in a MATLABMAT-file (compatible with MATLABr R2006b or later). The MAT-file include
all the analysis results and analysis parameters, exactly as they where when you saved the results. In addition,
these files include the raw data (ECG or RR data). This saving option has two purposes:

1. The main purpose of the MAT-file is that by opening the MAT-file in Kubios HRV, you can return to the previ-
ously performed analyses session as it was (all settings and analysis samples are presented as they were)
when the analysis was originally performed. Thus, the MAT file makes it easy for you to change something
in the analysis (e.g. add a new analysis sample or change some settings) and re-analyse the data. Thus, we
recommend that you save the analysis results always as a MAT-file, just in case if something needs to be
done differently.

2. In addition, the MAT files are useful for anyone working with MATLAB (further analysis or processing can be
performed easily by loading the MAT-files into MATLAB).

The MAT files include a single structured array variable named Res. The Res variable includes the numeric results
as well as the RR interval data and all the analysis options. The Res structure includes four fields which are shortly
described as follows

f_name: File name of the analysed data file
f_path: Full path for the analysed data file

CNT: Basic information of the data file (the field name refers to Neuroscan CNT-file
for historical reasons)

HRV: Used analysis options, RR interval data, and all analysis results.

The HRV field is the most essential one of these fields. The HRV field includes six fields the contents of which
are shortly described as follows

Param: The analysis options used in the calculation of the results
Data: The RR interval data

Summary: Results overview including PNS and SNS indexes
Statistics: Time-domain analysis results
Frequency: Frequency-domain analysis results
NonLinear: Nonlinear analysis results

TimeVar: Time-varying analysis results

The variable names of the different fields are more or less self-descriptive and are not documented here.

5.4 ”SPSS friendly” batch file (available in Premium)

In Kubios HRV Premium, you can also save the analysis results into a ”SPSS friendly” batch file. This saving options
is ideal for saving group results, for example if you need to analyse HRV data of several subjects and want to be
able to have the group results easily available for statistical testing e.g. in MS Excel or SPSS. Alternatively, you can
use the batch file saving option for saving HRV results of repeated personal recordings, e.g. to monitor training
effect or daily stress levels. Kubios uses Comma Separated Values (CSV) file format for the batch file, which can
be easily imported into many spreadsheet and statistical software packages (MS Excel, SPSS).

The Append to ”SPSS friendly” batch file functions as follows:

1. When saving the analysis results of the first subject (i.e. when you want to initialise a new CSV file), select
the destination and file name for the new CSV file from the file dialog. In this case, Kubios HRV will initialise
the CSV file by writing the column labels and add the analysis results into the first row below the column
labels.

2. When saving the analysis results of other subjects, simply select the previously saved CSV file. In this case,
Kubios HRV will add the results of the current analysis session into the last row of the file.

The structure of the ”SPSS friendly” batch file is presented in Fig. 25. Every row of the batch file consists of the file
name string and used analysis parameters values ([1x18] array); followed by the following information for every
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analysis sample: sample info consisting of sample onset/offset time and artifact correction statistics ([1x2] array),
and HRV analysis results ([1x82] array). For more details on the different HRV analysis variables please see Table
3.
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6 Kubios HRV preferences

Kubios HRV includes several settings related to how the ECG or RR interval data is processed and analysed. The
default values for these settings are designed to be suitable for short-term (normal human) HRV recordings, but
may sometimes need to be redefined. Some of these settings can be adjusted in the user interface to apply for
the current analysis session, but in order to make permanent changes into these settings you need to edit them at
software preferences. Preferences can be edited by selecting Edit Preferences from the File menu or by pressing
the corresponding toolbar button. This will open the preferences window in which the preference values can be
redefined. The preferences are divided into four categories: 1) User information, 2) Input data & pre-processing, 3)
Analysis options (divided into time/frequency-domain, nonlinear and time-varying subcategories), and 4) Report
settings.

In the User information settings shown in Fig. 13 you can set up your personal contact information (Name, De-
partment, and Organization). This information will only be included in the bottom left corner of the report sheet
and in the beginning of the ASCII text file including the analysis results. That is, the user information is meant
just for indicating the person/organisation that has carried out the analysis. The values given for Gender, Date of
birth, Height, Weight, rest HR and Max HR are used in HR zones, training impulse (TRIMP) and energy expenditure
computations.

Figure 13: Set up preferences window of the software – User information settings.

From the Input data & pre-processing settings shown in Fig. 14, you can change the default input data type
into any of the file formats mentioned in Section 2. The selected input data type is used as the default data type
every time a new data file is opened, so you can save one additional click by defining the data type you usually
work on as the default. The automatic signal quality detection level and default artifact correction method and
acceptance threshold can be modified here (see Sections 3.2 and 3.3). By default the acceptance threshold is set
to 5%, meaning that analysis samples having more than 5% trigger a warning of low quality data. Under Signal
type you can specify if you are using ECG or PPG data for HRV analysis (this has effect on the algorithm applied
in beat detection) and if you want to apply an Notch filter to remove power-line noise from the ECG signal (we
recommend using the Notch filter only when power-line noise distorts QRS detection). If you are using RR or IBI
data, this selection does not have any effect. When ECG is selected as signal type, you can modify QRS detection
settings. You can force Kubios to look for the R-waves either from positive of negative amplitudes, or let Kubios to
decide (R-wave polarity=Automatic). Also, you can manually fix the prior guess for the average RR interval (used
by the QRS detector as initial value), or let Kubios try to estimate it automatically. By default the QRS detection
settings are set to automatic and there is no reason to change them unless you are experiencing problems in
R-wave detection. If PPG is selected as signal type, you can modify the pulse acceptance threshold (not visible
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in Fig. 14 because ECG selected as signal type), which adjusts the sensitivity of the pulse detector algorithm. In
addition, the interpolation rate (by default a 4 Hz cubic spline interpolation is applied to form equidistantly sampled
time series from the IBI data) and detrending method (by default smoothness priors method is used to remove
very low frequency trend components) can be adjusted here. The default detrending settings will remove most
of the very low frequency components (frequencies below 0.04 Hz) from the RR interval series prior to analysis.
By doing so the HRV analysis results are not affected by the slow changes in HR level and are more sensitive to
the short-term HRV regulated by the autonomic nervous system. We recommend removing the trend using the
Smoothness priors method which was proposed in [29]. The default settings of the method are optimised for
human HRV, but if needed you can change the smoothness of the removed trend by editing the Lambda value.
The estimated cut-off frequency for the given Lambda value is presented next to the Lambda value edit box. In
the user interface, the trend removed from the RR interval data is shown as a red line over the analysed RR data
sample.

Figure 14: Set up preferences window of the software – Input data & pre-processing settings.

The Analysis options settings include some general analysis options, and detailed settings of different analysis
methods under three sections: 1) Time/frequency-domain, 2) Nonlinear and 3) Time-varying. The general analysis
settings shown in Fig. 15 includes selection of analysis to be performed: 1) Standard analysis (all time-domain,
frequency-domain and nonlinear analysis for selected stationary samples), and 2) Time-varying analysis. Only se-
lected analysis will be performed and thus un-checking unnecessary analysis type will speed up the computations.
Using the settings for RR interval samples, you can define how many analysis samples are generated by default
and what is the length of these samples. Also, the minimum analysis sample length can be defined between 10,
30 and 60 seconds. In case of several samples, you can choose the analysis type between Single samples (in
this case, Kubios will perform analysis for every sample separately) and Merge samples (the samples are merged
into one longer sample for which analysis is then performed). Finally, the Update mode can be changed between
Automatic (analysis results are refreshed automatically) and Manual (you need to refresh results manually).

The time and frequency-domain analysis settings are shown in Fig. 16. For time-domain analysis methods, you
can adjust the window width of the moving average filter (default 5 beats), which is used to extract minimum and
maximum HR values. Also, you can adjust the threshold used in the computation of NNxx and pNNxx parameters
(default 50 ms → NN50 and pNN50). Under HRV frequency bands, the very low frequency (VLF), low frequency
(LF), and high frequency (HF) bands of HRV frequency-domain analysis can be adjusted. The default values for
these frequency bands are VLF: 0–0.04 Hz, LF: 0.04–0.15 Hz, and HF: 0.15–0.4 Hz according to [30]. The rest
of the settings relate to spectrum estimation methods. The points in frequency-domain is given as points/Hz
and corresponds by default to the window width of the FFT spectrum. If spectrum interpolation is desired the
points in frequency-domain can be increased. The spectrum for the selected RR interval sample is calculated
both with Welch’s periodogram method (FFT spectrum) and with an autoregressive modeling based method (AR
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Figure 15: Set up preferences window of the software – Analysis options settings.

spectrum). In the Welch’s periodogram method, the used window width and window overlap can be adjusted by
editing the corresponding value. The default value for window width is 300 seconds and the default overlap is
50 % (corresponding to 150 seconds), which produce three overlapping windows for a 10-min (600 sec) analysis
sample. As an alternative to FFT spectrum, you can select to use the Lomb-Scargle periodogram, which does not
assume equidistant sampling and has been recommended for HRV spectral analysis in some studies. The default
smoothing window for this spectrum estimate is 0.02 Hz. For the AR spectrum, there are two options that can be
selected. First, the order of the used AR model can be selected. The default value for the model order is 16. The
second option is whether or not to use spectral factorization in the AR spectrum estimation. In the factorization
the AR spectrum is divided into separate components and the power estimates of each component are used for
the band powers. Spectral factorisation has been shown to provide some advantage especially when e.g. the HF
component is partially overlapping with the LF band [27].

The nonlinear analysis settings are shown in Fig. 17. As the first option, you can choose if the nonlinear parameters
are also computed from the detrended RR interval data or not (by default computations are made from detrended
data). If you uncheck this option, then all nonlinear parameters are always computed from non-detrended RR
interval data. The embedding dimension m (default 2 beats) and the tolerance value r (default 0.2 times SD)
used in for the computation of Approximate entropy (ApEn) and Sample entropy (SampEn) can be modified. Note
that the tolerance value is adjusted in relation to the standard deviation of the RR interval data. Next, limits of
the short-term (N1) and long-term fluctuations used in the Detrended fluctuation analysis (DFA) can be modified
(defaults 4-12 and 13-64 beats, respectively). Finally, the embedding dimension (default 10 beats) used both in the
computation of the Correlation dimension (D2) and in the Recurrence plot analysis (RPA), and the threshold level
(default

√
10) used in RPA, can be modified.

The time-varying analysis settings are shown in Fig. 18. You can choose to apply time-varying analysis (analysis
mode) on the whole measurement (default) or for analysis samples. You can adjust the width (default 300 sec)
and grid interval (default 60 sec) of the moving window used for time-varying analysis. Note than the analysis
window for energy expenditure (EE) and TRIMP can be defined separately, because youmay want these estimates
to be more instantaneous in nature. The grid interval defines how much the window is moved at every step, and
analysis results are available at these intervals. For example, if you want to performe time-varying analysis at 10-
min non-overlapping segments for the whole duration of recording, you select ”Whole recording” as the analysis
mode and define the window width and grid interval both to 600 seconds. Effective data threshold setting adjusts
how noise segments affect time-varying analysis results, by default results are not computed unless the effective
RR data length (length of data excluding noise) is at least 50% of the analysis window width. For the time-varying
spectrum estimation there are two options: 1) the well known spectrogrm (default) and 2) a Kalman smoother
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Figure 16: Set up preferences window of the software – Analysis options: time-/frequency-domain methods.

Figure 17: Set up preferences window of the software – Analysis options: nonlinear methods.

spectrum estimate proposed in [27].

The Report settings shown in Fig. 19 include the following options. The contents of the results to be exported
can be selected by checking the Standard and/or Time-varying results options. If either one of these is unchecked,
only the selected results will be exported (in PDF reports or the other export file formats). Concerning the ASCII
text file as well as the ”SPSS friendly” CSV batch file, the field delimiter and decimal point used when saving the
results can be selected (the default values being comma ”,” for field delimiter and dot ”.” for decimal separator).
The paper size of the report page(s) can be changed between A4 (210×297 mm) and Letter (8.5×11 inch) size.
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Figure 18: Set up preferences window of the software – Analysis options: time-varying methods.

Only one spectrum figure is shown in the report page, but you can here choose if you want to show the FFT/Lomb
or the AR spectrum estimate. For the time-varying report page you can choose four optional HRV parameters to
be displayed under time-varying analysis results.

Figure 19: Set up preferences window of the software: Report settings category.

All modifications for the preferences are saved by pressing the OK button. Please note that the changes made
into preferences take effect only after restarting Kubios HRV (either closing the analysis session or closing the
program). In addition to above described analysis options, there are various other editable options which have
mainly influence on the usability of the software. Such options are e.g. the Range and Y-limit values of the data
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axis and various visualization options. The values of these options are preserved in memory and any changes
made to them will be applied in the future sessions.

All the preferences and preserved options used by Kubios HRV are saved in user specific folders2.

Windows 7,8 or 10:

HRV Standard: C:\Users\<username>\AppData\Roaming\Kubios\KubiosHRVStandard

HRV Premium: C:\Users\<username>\AppData\Roaming\Kubios\KubiosHRVPremium

Mac OSX:

HRV Standard: ~/Library/Preferences/Kubios/KubiosHRVStandard

HRV Premium: ~/Library/Preferences/Kubios/KubiosHRVPremium

Linux:

HRV Standard: ~/.kubios/KubiosHRVStandard

HRV Premium: ~/.kubios/KubiosHRVPremium

where <username> is the name of your user profile. The folder will include a file named KubiosHRVprefs.mat,
which includes all the preferences for the analysis options, user information and user interface usability. The file
is created when Kubios HRV is started for the first time and it will be updated whenever the preference values are
edited/updated. The original settings of the preferences can be restored by deleting this preference file. Also, if
the preference file gets somehow corrupted, the preference file will be rewritten using the default values.

2Note that the AppData folder in Windows is hidden by default and are not visible in the File Explorer if the “Show hidden files and folders”
is not selected from the “Folder Options” section of the File Explorer.
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7 Kubios HRV analysis parameters

Kubios HRV is provides a detailed analyses of HRV with over 40 analysis parameters. Summary of all HRV param-
eters calculated by Kubios HRV is given in 3.

Table 3: HRV parameters calculated by Kubios HRV software (* only preview is available in Standard version; **
parameters are available only in Premium version).

Parameter Units Description References
Overview
Stress index - Square root of Baevsky’s stress index [2]
PNS index - Parasympathetic nervous system activity compared to normal resting values
SNS index - Sympathetic nervous system activity compared to normal resting values
HR zones* [%] Time spent in Maximum, Hard, Moderate, Light, Very light, and Inactive HR zones
PNS zones* [%] Time spent in Very high, High, Normal, Low and Very Low PNS index levels
SNS zones** [%] Time spent in Very high, High, Normal, Low and Very low SNS index levels
Energy exp.* [kcal/min] Activity related energy expenditure (EE) estimated using Keytel’s model [13]
TRIMP* [TRIMP/min] Training impulse (TRIMP) according to Banister’s exponetial model [18]
Time-Domain
RR [ms] The mean of RR intervals
STD RR (SDNN) [ms] Standard deviation of RR intervals
HR [1/min] The mean heart rate
STD HR [1/min] Standard deviation of instantaneous heart rate values
Min & Max HR [1/min] Minimum and maximum HR computed usingN beat moving average (default value: N = 5)
RMSSD [ms] Square root of the mean squared differences between successive RR intervals
NNxx [beats] Number of successive RR interval pairs that differ more than xx ms (default value: xx= 50)
pNNxx [%] NNxx divided by the total number of RR intervals
HRV triangular in-
dex

- The integral of the RR interval histogram divided by the height of the histogram [30]

TINN [ms] Baseline width of the RR interval histogram [30]
DC, AC** [ms] HR deceleration capacity (DC) and acceleration capacity (AC) [3, 21]
SDANN [ms] Standard deviation of the averages of RR intervals in 5-min segments [30]
SDNNI [ms] Mean of the standard deviations of RR intervals in 5-min segments [30]
Frequency-Domain
Spectrum Welch’s (or Lomb-Scargle*) periodogram and AR spectrum estimates
Peak frequency [Hz] VLF, LF, and HF band peak frequencies
Absolute power [ms2] Absolute powers of VLF, LF, and HF bands
Absolute power [log] Natural logarithm transformed values of absolute powers of VLF, LF, and HF bands
Relative power [%] Relative powers of VLF, LF, and HF bands

VLF [%] = VLF [ms2]/total power [ms2]× 100%
LF [%] = LF [ms2]/total power [ms2]× 100%
HF [%] = HF [ms2]/total power [ms2]× 100%

Normalized power [n.u.] Powers of LF and HF bands in normalised units
LF [n.u.] = LF [ms2]/(total power [ms2]− VLF [ms2])
HF [n.u.] = HF [ms2]/(total power [ms2]− VLF [ms2])

LF/HF - Ratio between LF and HF band powers
RESP** [Hz] Respiration rate (derived from ECG and RR data)
Nonlinear
SD1 [ms] In Poincaré plot, the standard deviation perpendicular to the line-of-identity [5, 6]
SD2 [ms] In Poincaré plot, the standard deviation along the line-of-identity
SD2/SD1 - Ratio between SD2 and SD1
ApEn - Approximate entropy [26, 9]
SampEn - Sample entropy [26]
DFA, α1 - In detrended fluctuation analysis, short term fluctuation slope [23, 24]
DFA, α2 - In detrended fluctuation analysis, long term fluctuation slope
D2** - Correlation dimension [11, 12]
RPA**: Recurrence plot analysis: [31, 8, 33]
Lmean [beats] Mean line length
Lmax [beats] Maximum line length
REC [%] Recurrence rate
DET [%] Determinism
ShanEn - Shannon entropy

MSE** - Multiscale entropy for scale factor values τ = 1, 2, . . . , 20 [7]
Time-Varying**
Overview parameters: Stress index, PNS index, SNS index, EE, TRIMP and RESP
Time-domain parameters: RR, SDNN, HR, STD HR, Min HR, Max HR, RMSSD, NNxx, pNNxx, HRV tri ind., TINN
Frequency-domain parameters: Time-varying spectrum (Spectrogram); VLF, LF and HF peak frequencies;

VLF, LF and HF powers in ms2 , log and %; LF and HF powers in n.u.; LF/HF ratio
Nonlinear parameters: SD1, SD2, SD2/SD1, ApEn, SampEn, DFA α1 and α2
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A Appendix: Polar Flow export (available in Premium)

The Polar Flow export option provides an easy way to export your Polar Flow measurements into your computer
hard drive in FIT file format, which can then be analyzed in Kubios HRV software. Previously, Polar users were able
to export RR data from Polar Flow only when using the RR recording test available in Polar V800. However, by
using the new Polar Flow export functionality, you will have access to the RR data required for HRV analysis from
all Polar Flow compatible Polar devices when using them with H6, H7 or H10 heart rate sensor (NOTE: RR data is
not available whenmeasuring with the Polar Beat App). Furthermore, you can access the RR data also from your
exercise mode measurements (which has not been possible before even with the V800 monitor). In order to start
exporting your Polar Flowmeasurements, click Polar Flow Export in Toolsmenu and follow given instructions. The
steps needed to link your Polar Flow account with Kubios HRV are shortly described below. Please note that only
those training sessions that are added to Polar Flow after linking with Kubios HRV are accessible through Polar
Flow API.

Please remember that:

1. ONLY MEASUREMENTS MADE AFTER LINKING YOUR POLAR FLOW ACCOUNT ARE ACCESSIBLE

2. RR data is available only when a chest strap (H6, H7 or H10) has been used

3. Each measurement can be exported only once (take backup copies of exported data files).

When you click the Polar Flow Export option for the first time, a window instructing you to sign in to your Polar
Flow account pops up

Click ”Sign in to Polar Flow” to continue.
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Next, you need to Sign In to your Polar Flow account and give Kubios HRV permission to access your Polar Flow
account data. To continue, confirm that you agree to the Terms and Conditions and click Accept. You should then
receive a notice that your Polar Flow account is successfully linked with Kubios HRV.

Once you have linked your Polar Flow account with Kubios HRV, you can export your training data by clicking the
Polar Flow Export from Tools menu.

You can define the export folder, where your training data from Polar Flow will be exported. Every training mea-
surement that you have uploaded into Polar Flow after linking your account with Kubios HRV or after the previous
successful export, will be exported into the selected folder in FIT file format when clicking Export Training Data
button.
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If you do not have newmeasurements uploaded to Polar Flow, you will receive a notification ”No new training data
available in Polar Flow”. Please note, that not all the FIT files exported from Polar Flow necessarily include RR data
and can not thus be opened in Kubios HRV. RR data is available only when you have used a chest strap (Polar
H6, H7 or H10) to record heart rate. RR data is not available when you have measured heart rate from your wrist
(wrist-based HR) or by using the optical Polar OH1 armband.

You can Unlink Kubios HRV from your Polar Flow account whenever you want. However, you should do this only if
you do not anymore need to access your training data in Kubios HRV. If you want to temporarily disable the access
to your Polar Flow account from Kubios HRV, you can Sign Out from your account instead. In this case, you are
required to sign in again the next time you want to export data from Polar Flow, but all your latest training data are
still accessible through the Polar Flow link.
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B Appendix: Kubios HRV figures

Figure 20: The printout of the ECG signal generated by the software.
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Figure 21: Kubios HRV Premium results for exercise test saved as a CSV formatted text file, showing time-domain,
frequency-domain and nonlinear HRV analysis results for different exercise protocol time periods (Rest, Warm-up,
40W load, 80W load, and 120W load).

© 2016-2021 Kubios Oy WWW.KUBIOS.COM



36

Figure 22: Kubios HRV Premium time-varying analysis results saved as a CSV formatted text file. In this case,
time-varying results were computed at 120-sec window with 10-sec grid interval. Note: only the first few columns
of results are shown.
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Figure 23: Kubios HRV Premium report page showing HRV analysis results for healthy young male during supine
rest (5-min analysis sample).
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Figure 24: Kubios HRV Premium report page showing time-varying analysis results for maximal cardiopulmonary
exercise test performed by healthy young male.
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A)
Sample 1 (S1) SampleN (SN )

Files analysed Parameters Info HRV results … Info HRV results
FileName PRM#[PARAMETERS] S1_[INFO] S1_[VARIABLES] ... S1_[INFO] S1_[VARIABLES]
subject_1.txt [1x18] array [1x2] [1x82] … [1x2] [1x79]
subject_2.txt [1x18] array [1x2] [1x82] … [1x2] [1x79]
...

...
...

...
...

...
subject_M.txt [1x18] array [1x2] [1x82] … [1x2] [1x79]

B)
Parameters
#Detrending: Detrending method used #WelchWindow: Window width (overlap) in Welch
#InterpRate: Interpolation rate of RR data #LombWindow: Smoothing window width in Lomb periodogram
#MinMaxHR: Nbr of beats averaged for Min/Max HR #ARspectrum: Order of AR spectrum (factorisation)
#NNxxThreshold: Threshold for NNxx and pNNxx in msec #Entropy: Embedding dimension (tolerance)
#VLFband: VLF frequency band limits in Hz #DFAshortterm: DFA, short-term fluctuations range
#LFband: LF frequency band limits in Hz #DFAlongterm: DFA, long-term fluctuations range
#HFband: HF frequency band limits in Hz #RecurrencePlot: RPA, embedding dimension (threshold)
#FreqPoints: Nbr of points in spectra (points/Hz) #NbrSamples: Number of analysed samples
#FFTorLomb: FFT (Welch) or Lomb periodogram used #ArtifactCorrection: RR artifact correction method

Sample Info
Onset-Offset: Sample onset-offset times (hh:mm:ss) Beats corrected (%): Corrected beats within the sample

HRV variables
PNS index: Parasympathetic nervous system tone index VLFpeak_AR (Hz): VLF band peak frequency (AR spectrum)
SNS index: Sympathetic nervous system tone index LFpeak_AR (Hz): LF band peak frequency (AR spectrum)
Stress index: Square root of Baevsky’s stress index HFpeak_AR (Hz): HF band peak frequency (AR spectrum)
Mean RR (ms): Mean of RR intervals VLFpow_AR (ms2): Absolute VLF power (AR spectrum)
SDNN (ms): Standard deviation of RR intervals LFpow_AR (ms2): Absolute LF power (AR spectrum)
Mean HR (bpm): Mean heart rate HFpow_AR (ms2): Absolute HF power (AR spectrum)
SD HR (bpm): Standard deviation of heart rate VLFpow_AR (log): Log VLF power (AR spectrum)
Min HR (bpm): Minimum HR usingN beat MA LFpow_AR (log): Log LF power (AR spectrum)
Max HR (bpm): Maximum HR usingN beat MA HFpow_AR (log): Log HF power (AR spectrum)
RMSSD (ms): RMS of successive RR interval differences VLFpow_AR (%): Relative VLF power (AR spectrum)
NNxx (beats): Nbr or successive RRs > xx ms LFpow_AR (%): Relative LF power (AR spectrum)
pNNxx (%): Percentage of successive RRs > xx ms HFpow_AR (%): Relative VLF power (AR spectrum)
HRV triangular index: RR histogram area/height LFpow_AR (n.u.): Normalised LF power (AR spectrum)
TINN (ms): RR histogram baseline width HFpow_AR (n.u.): Normalised HF power (AR spectrum)
DC (ms): HR deceleration capacity TOTpow_AR (ms2): Total spectral power (AR spectrum)
DCmod (ms): Modified HR deceleration capacity LF_HF_ratio_AR: LF/HF power ratio (AR spectrum)
AC (ms): HR acceleration capacity
ACmod (ms): Modified HR acceleration capacity RESP (Hz): Respiration rate
SDANN (ms): SD of 5-min RR interval segment means
SDNNI (ms): Mean of 5-min RR interval segment SDs SD1 (ms): Poincaré plot short term variability
VLFpeak_FFT∗ (Hz): VLF band peak frequency (FFT) SD2 (ms): Poincaré plot long term variability
LFpeak_FFT (Hz): LF band peak frequency (FFT) SD2_SD1_ratio: SD2/SD1 ratio
HFpeak_FFT (Hz): HF band peak frequency (FFT) ApEn: Approximate entropy
VLFpow_FFT (ms2): Absolute VLF power (FFT) SampEn: Sample entropy
LFpow_FFT (ms2): Absolute LF power (FFT) D2: Correlation dimension
HFpow_FFT (ms2): Absolute HF power (FFT) DFA1: DFA, short term fluctuations slope
VLFpow_FFT (log): Log VLF power (FFT) DFA2: DFA, long term fluctuations slope
LFpow_FFT (log): Log LF power (FFT) RP_Lmean (beats): RPA, mean line length
HFpow_FFT (log): Log HF power (FFT) RP_Lmax (beats): RPA, maximum line length
VLFpow_FFT (%): Relative VLF power (FFT) RP_REC (%): RPA, recurrence rate
LFpow_FFT (%): Relative LF power (FFT) RP_DET (%): RPA, determinism
HFpow_FFT (%): Relative HF power (FFT) RP_ShanEn: RPA, Shannon entropy
LFpow_FFT (n.u.): Normalised LF power (FFT) MSE_1 …MSE_20: Multiscale entropy for scales τ = 1, . . . , 20
HFpow_FFT (n.u.): Normalised HF power (FFT)
TOTpow_FFT (ms2): Total spectral power (FFT)
LF_HF_ratio_FFT: LF/HF power ratio (FFT)

∗ If Lomb-Scargle periodogram is used instead of Welch’s pe-
riodogram, FFT → Lomb

Figure 25: Structure of the ”SPSS friendly” batch file: A) overview of the file structure and B) short description of
the fields.
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